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The following changes have been made to DAT/EM products between Release 7.6 and Release 7.7. Please review these 
revisions made to the software and update your software to implement changes. As always, DAT/EM welcomes 
comments and suggestions from you, our clients, so please don’t hesitate to contact our support department at 
support@datem.com or call us with your requests. 
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Operating Systems and Microsoft Updates 
DAT/EM software no longer supports 32-bit operating systems. If you attempt to install the software on a 32-bit 
operating system (OS), some parts may work, but DAT/EM will not guarantee that everything will work. DAT/EM will not 
fix any 32-bit OS-related problems. DAT/EM will not support any 32-bit OS at any time in the future. 

Any reference to an OS in the remainder of this document refers to the 64-bit version of that OS only. 

DAT/EM Release 7.7 is supported on the following operating systems: 

• 64-bit Windows 8.1 Professional and Enterprise. Notes: 

o Microsoft and DAT/EM no longer support Windows 8.0. Microsoft recommends Windows 8.1 as a service 
pack for 8.0, but also recommends Windows 10 above 8.1. 

o DAT/EM will stop supporting Windows 8.1 when Microsoft ends extended support on January 10, 2023. 

o DAT/EM doesn’t test rigorously on Windows 8.1. All of our most accessible test computers have 
Windows 10. We consider this a reason to encourage you to upgrade to Windows 10 sooner than 2023. 

o If you need to choose between Windows 8.1 and 10, DAT/EM recommends Windows 10. 

• 64-bit Windows 10 Professional and Enterprise. Notes: 

o DAT/EM generally recommends installing all Windows updates; however, if you are using nVidia 
3DVision and a Microsoft semi-annual channel update greater than 1909, please check with DAT/EM to 
ask whether 3DVision still works with the newer channel update. We will continue to test the Microsoft 
Windows 10 semi-annual channel updates for compatibility with 3DVision and the April 2019 nVidia 
3DVision drivers. 

o If using nVidia 3DVision stereo with Windows 10, use an nVidia Quadro K-, M-, or P-series video card 
with the driver recommended by DAT/EM Support. Exception: Do not use the Quadro P2200, which was 
released after the last 3DVision driver date. 

o DAT/EM software does not work with Windows 10 LTSC. 

 

Hardware Locks/Dongles 
Install Microsoft Updates before applying lock reset programs. Network licensing should have the same Sentinel driver 
version on both the server and the local computers running the software. 
 
The Gemalto Sentinel driver version 7.6.9 is provided with DAT/EM version 7.7. If Sentinel 7.6.9 was not previously 
installed by DAT/EM v.7.6, the first run of the DAT/EM self-extracting executable or DAT/EM’s newest prerequisites 
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installation will install or update the Sentinel driver to 7.6.9. Answer Upgrade to the Confirm Upgrade dialog, accept the 
license agreement, and answer “Yes” to Sentinel’s firewall question and reboot when asked. 

  

  
 

 
It is very important to answer “Yes” to this question and reboot when done 

 
Sentinel Driver on Network Lock Servers: If you have a network lock on a network server and it is not already 
running Sentinel v.7.6.9, DAT/EM strongly advises you to install Sentinel 7.6.9 on the network lock server to 
match the version on the DAT/EM workstations. Please be aware that in our tests so far, Sentinel 7.6.9 seems to 
communicate well with Sentinel 7.6.8. This means you can schedule the update to Sentinel 7.6.9 on your 
network lock server for a convenient time, either before or after you update the workstations. For example, 
you could install it right before its next scheduled reboot. DAT/EM provides a convenient prerequisites file that 
installs the C++ redistribution files (Microsoft files required to run Sentinel) and the Sentinel 7.6.9 driver: 

• Datem_PreReqs_blt_11_15_2018.exe 
• This is www.datem.com > Support > Downloads > Prerequisites > “Prerequisites installation, 

includes Visual C++ Redistributables and Sentinel 7.6.9 - EXE version” 
• Highlights of the driver are listed here at the Gemalto website: 

https://supportportal.gemalto.com/csm?id=kb_article_view&sysparm_article=KB0016451  
• Answer “Yes” to Sentinel’s firewall question (see images above). 
• Reboot the server after installation. 

Please do not completely skip the update for the network lock server. The newer Sentinel driver works 
better, and the best communication can be expected when the Sentinel versions match. 
 

http://datemsystems.com/down/Datem_PreReqs_blt_11_15_2018.exe
http://www.datem.com/
https://supportportal.gemalto.com/csm?id=kb_article_view&sysparm_article=KB0016451
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**VR is Back!** DAT/EM Virtual Reality (VR) 
1. DAT/EM Virtual Reality (VR) is re-released in DAT/EM version 7.7. It is now developed with Amazon 

Lumberyard®, making it compatible with almost any brand of VR headset. (April 21, 2020) 

You may either load the Terrain Project directly in VR to fly through them or start the DAT/EM VR Desktop and 
run Summit Evolution. (Do not use DAT/EM Point Cloud with VR; it was designed for use without VR and is not 
compatible with the DAT/EM VR Desktop.) 

Previously, only the Oculus Rift® was compatible with DAT/EM VR, but many customers wanted a higher 
resolution device. The HTC Vive Pro® has a higher resolution and enjoys excellent reviews from DAT/EM’s 
software engineers. These along with many other brands of VR headsets are supported. 

The DAT/EM VR Desktop has two main parts: 

• Part 1:  The DAT/EM VR Desktop, which is a Windows desktop in VR. There are other VR desktop 
applications, but what makes DAT/EM’s special is that we can show our quad buffered applications in 
stereo inside VR. Showing Stereo is special and a general VR Desktop cannot do it.  

Use of VR input controllers for the DAT/EM VR Desktop: 

o Holding the Left Index trigger positions the desktop at your hand. While holding, press Right 
Index Trigger to make the desktop disappear. Press Left Index Trigger to bring it up again. 

o When pointing at the desktop, Left Trigger is the left mouse button and Right Trigger is the right 
mouse button. 

o When pointing at Summit, you can control Summit with the VR joystick controls. Left Joystick 
is XY movement and Right Joystick is Z movement. 

 

• Part 2:  Load Terrain Projects and fly around the points in VR. This also supports Superimposition and 
DAT/EM Capture.  You can see CAD drawings in VR and Edit/Collect on those drawings using VR 
controllers. 

Use of VR input controllers for flying through points: 

o Use Left and Right Joysticks to fly around through the points. 

o Left Trigger is Pick.  

o Right Trigger is Cancel.  
o Right Index Trigger is Teleport. Point at the desired location and then pull the right index trigger 

to go there.  

The controller settings to perform actions are currently hard coded. 

Known bug remaining unresolved in v.7.7: Stereo windows such as Summit can have problems. The more you 
move or size them, the more likely it will be to give a “Surface lost error” and a shutdown of VR. 

 
Amazon Lumberyard is a trademark of Amazon.com, Inc. or its affiliates in the United States and/or other countries. Oculus Rift is a trademark 
of Facebook Technologies, LLC. HTC Vive is a trademark of HTC Corporation. 

 

   

Stereo Viewing Devices and Drivers 
Please contact DAT/EM Support if you have any questions about setting up nVidia 3DVision, buying 3DVision-compatible 
monitors, or setting up any other brand of stereo monitor. We have collected too much information to include here. 
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Software Installation, File Locations, and Installed Utilities 
The following has changed for DAT/EM software installation or the location where DAT/EM applications store data: 

1. The installation process will set the Windows default application to DAT/EM Point Cloud for the .vrldr format. (May 
17, 2019) 

2. DAT/EM Release Information will now show “Beta”, “RC” (Release Candidate), or Release to indicate whether it 
is a final release or not. (September 23, 2019) 

3. The DAT/EM CAD Enabler can now enable and disable applications for 32- and 64-bit MicroStation versions 
separately. Note that V8 2004 Edition, XM, and V8i SelectSeries are all 32-bit versions, and any products with 
“CONNECT” or “Open” in the name is a 64-bit version. (May 14, 2020) 

 

 
CAD Enabler with separate 32- and 64-bit MicroStation options 

DAT/EM Keypad 
The following changes have been made to the DAT/EM Keypad products: 

1. *New!* The Standalone DAT/EM Keypad for MicroStation is a new product. (A similar product already exists 
for recent versions of AutoCAD.) The Standalone Keypad application can install by itself and send commands 
directly into MicroStation without requiring MicroStation to have Windows focus. It may be useful for: (Nov. 4, 2019) 

• Editing workstations 

• Anyone who does repetitive tasks in MicroStation 

• Users who have no other DAT/EM software, but who use MicroStation often in their work 

Compatible versions of MicroStation are: 

• V8i SelectSeries 4, 10, and SES 

• MicroStation CONNECT update 13. 

Other versions could possibly be added by request. 

Most often, this application will be used on screen with the mouse, on a TouchScreen, or with the DAT/EM 
Keypad Advantage. The Keypad Advantage is a user-supplied Android tablet and Bluetooth adapter. The 
application will also work with the older DAT/EM-manufactured keypad devices and touchscreen monitors.  

DAT/EM Summit with Capture for MicroStation and MapEditor users take note: This product may be useful to 
your coworkers or clients who commonly use MicroStation. Now when they say how much they like your DAT/EM 
Keypad, you can let them know it’s available to them, too. Contact DAT/EM or your DAT/EM reseller for a quote. 

The Standalone DAT/EM Keypad for MicroStation uses a configuration file to load an application in MicroStation, 
depending on the version of MicroStation: 
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MS_DGNAPPS  > $(DATEM_DIR_USTN)/KeyPadConn.ma 

or 

MS_DGNAPPS  > $(DATEM_DIR_USTN)/ KeyPadss10Dll.ma 

 

2. The Keypad Controller has new Paste Color and Paste Shape options. These appear in the right click menu and 
on the Edit menu. Keyin accelerators are <CTRL><SHIFT>C for color and <CTRL><SHIFT>S for shape. (April 16, 
2020)  

These options both work after using Copy, but instead of pasting the whole copied key, they only paste the 
copied key’s color or the key size (such as 2x3). 

 
New Paste Color and Paste Shape options in the Keypad’s right click menu 

3. There is a change to correct a problem in the text style for key labels. Sometimes the “strikeout” style would not 
follow the current dialog checkbox settings. (November 21, 2019) 

 

4. Multiple instances of the DAT/EM Keypad may now run at the same time. Each one may communicate with a 
different Keypad hardware device or the on-screen “TouchScreen” version. This is done through command line 
parameters, which can also be added to the end of a desktop shortcut Target (see example below). The 
parameters are not case sensitive. (February 6, 2020) 

 
-m Allow multiple instances of Keypad. If this is not set, then the second run of Keypad 

just brings the first one to the front as usual. 
 
-TouchScreen Sets the Keypad to be a touch screen (also used for any desktop monitor). No device 

connection is needed here. 
 
-Android The new device will connect to an Android tablet. If the Android app is launched after 

launching the Keypad Controller, it connects. 
 
-Overlay "<full path>\<File name.dkf>" 
Example: -overlay “C:\My keypad files\Airfield Obstruction Projects.dkf” 

Sets an overlay on the command line rather than have it automatically load the most 
recently open file. This does not modify the most recent filename stored. Enclose the 
path and file name in double quote characters. Windows Hint: If you hold down the 
<Shift> key while you right click on a file name in File Explorer, you can select “Copy 
as path” from the menu, then paste into this string. It will even paste the double quote 
characters. 
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Example of a pair of desktop shortcuts set to multiple keypads, one starting a TouchScreen and the other starting 
the Android version: 

In this example, we make two shortcuts for this application: 

"C:\Program Files (x86)\Datem Software\KeypadController.exe" 

Edit the shortcut name as you want to be able to tell them apart. Right click on each and select 
Properties and add the new flags to the end of the Target (beyond the last double quote character): 

 

    
Example of two shortcuts starting two instances of the DAT/EM Keypad, automatically connecting to the 

specified device type, and automatically loading a specific Keypad overlay .dkf file 

 

 

Coordinate Transformations and Elevation Database 
There have been no changes to the elevation database installation file built in 2015 and found here: 
http://datemsystems.com/down/SetupElevationModels%20blt%2003%2015%202015.exe. If you already installed that file 
with previous DAT/EM versions, you do not need to reinstall it. Any changes have been added to the DAT/EM setup 
installation, so that you do not need a new, separate Elevation Database file. 

The following change is in DAT/EM version 7.7: Blue Marble Geographics’ GeoCalc version 7.5 has been incorporated by 
license into DAT/EM software version 7.7. Changes include the addition of the United States Geoid 18. For a complete list 
of changes related to Blue Marble GeoCalc version 7.5, see the Blue Marble Geographics website. (March 9, 2020 and later. 
Completed in Late March.) 

 

http://datemsystems.com/down/SetupElevationModels%20blt%2003%2015%202015.exe
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DAT/EM Stereo Viewer 
The DAT/EM Stereo Viewer was added in DAT/EM version 7.6. For instructions on how to use the Stereo Viewer, please 
see the new Stereo Viewer Operation Manual available from www.datem.com > Support > Downloads > Manuals > 
Stereo Viewer. 

The following changes have been made to Stereo Viewer: 

1. Stereo Viewer’s automatic alignment function would crash with 16-bit images. This is fixed. (September 26, 2019) 

2. Stereo Viewer’s manual alignment function has the following changes: 

a. It would display 16-bit images as all black. This is fixed. (September 26, 2019) 

b. The Stereo Viewer was not installing together with Summit Professional, if Summit Professional was 
licensed. This is fixed. (April 30, 2019) 

c. The Auto Next function now defaults to off. (September 26, 2019) 

d. Stereo Viewer has a new Quick Points function to help quickly add Von Gruber and picked point 
positions. (September 26, 2019) 

 

 

http://www.datem.com/
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e. Stereo Viewer has a new left-pick system mouse measurement method. It is only available when the side-
by-side checkbox is on. Previously, there were extra clicks to lock and unlock the images during 
alignment. With the new method, simply pick directly with the system mouse on the same object in the left 
and right (side-by-side) views. The old method is still available, but the new method is recommended, 
because it’s faster to use. (September 26, 2019)  

 
 

 

Summit Evolution 
The following changes have been made to Summit Evolution and the applications that are provided with it.  

 
General Summit Evolution Subjects 

1. The Control Editor’s coordinate conversion tool has the following changes: (July 22, 2019) 

a. The coordinate system selection dialogs would sometimes launch behind other dialogs and would not 
come forward, so they were essentially invisible to the user. This is fixed. 

b. When you selected the “Transforms” button and selected the transformation settings, the resulting display 
would clear the previous vertical selection. Then if you reselected the vertical, the transformations would 
not be offered again. These issues are fixed. 

c. The “Swap” button has been removed. It was incompatible with the new method of selecting 
transformations. Now the user will need to select the correct order of the input and output systems. 

d. The dialog is now resizable so that you can view more characters in the selected settings display. 
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2. The current selection or selections in Summit’s Project window lists (Images, Models, Strips, Groups, Projects) 
will be more obvious now. Previously, it was such a light gray, it was difficult to see that it was selected. (July 24, 
2019) 

3. Summit > Imagery > Auto Localized Image Now and Automatic Localized Adjustment are improved for better 
viewing comfort and color matching. The new algorithm addresses three main subjects:  (August 2, 2019) 

a. It is now background threaded. Previously, it tried to do this work in the main thread. This resulted in 
potential stops in movement. The new algorithm does more work and is therefore slower, so it required 
this enhancement. 

b. The right image is now matched to the left. Previously, if the colors in the left and right image were much 
different from each other, such as the presence of a blue car in the left and a red car in the right, they 
could produce distinctly different histograms. Now it first equalizes the left image, then the right image is 
matched to look like the left. The result is that the right gets some equalization from the left, not just from 
itself, and this makes its colors match the colors in the left image better. 

c. It will force a refresh at the time you click the auto localized histogram button. Previously, it might refresh 
only after you moved the cursor. (September 20, 2019 or earlier) 

d. Image blowout reduction. In previous versions, the equalization could be a bit extreme, such as very 
black, blue, or red. This effect has been reduced. 

   
The old Localized Histogram method could be very different in the left and right. In this extreme example, 
the red truck carrying the blue car is only in the right image and greatly affected the histogram. 

   

The new Localized Histogram method is improved. Although the colors in this extreme example are still 
(and will always be!) different due to the strong car colors in only one image, they are matched enough to 
make viewing in stereo much easier. 
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4. True 16-bit images that used the entire 16-bit color range could show anomalies that looked like dark-colored 
spots in the Summit main view. These were especially visible when zoomed in to a dark area of the image, 
particularly in shadows or on dark-colored objects. This is fixed for v.7.7. Note: The presence of a .histohfa 
histogram file (DAT/EM Image Creator and Summit > Imagery > Project Histogram will generate them) or applying 
a histogram adjustment to the view would prevent the problem in older versions. (February 19, 2020) 

  
Left: 16 bit image with display anomalies.       Right: V.7.7 display. 

5. Summit .smtxml projects made by Trimble’s Inpho software might contain relative paths to the images. These 
include the characters “..\..\” and refer to the current project folder and its folder tree. Summit previously did not 
recognize relative paths. Summit needs to have absolute paths that list a specific drive and folder name. Now the 
first time Summit opens the file and encounters relative paths, it will do a one-time path substitution. When 
Summit saves the project, it will be with all absolute paths to images, cameras, and control files.  (September 24, 
2019) 

6. A new Read Me button appears on the Z Index dialog. It shows a message about the right and wrong ways to 
use Z Index. This was prompted by too many users attempting to correct project problems using Z Index, which is 
not intended for and not designed for that use. (April 27, 2020) 

 
New Z Index Information button 
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7. In an .smtxml project, multiple viewports now better regulate the setting of “Automatically open next model” for 
each viewport based on the current setting of Summit > Tools > Options > Project tab > “Automatically load next 
model when outside stereo region” (referred to as the “main setting” ).This is how it works: 

 
The “main setting” is in Tools > Options > Project 

a. If the main setting is OFF, then all viewports will have their settings OFF and inactive. The individual 
viewports’ “automatically load next…” icons will grey out like this: 

 
The main setting is off, so all viewports’ icons will be inactive 

This will now clearly show that “auto next model” is not active in any viewport. (To change it, turn on the 
main setting.) 

b. If the Summit’s main option is ON, then the focus viewport (which has a blue title bar) will always match 
the main setting and will show a blue icon with a checkmark: 

 
If the main setting is on, the focus viewport will have its setting on 

This icon with the checkmark can’t be changed from the focus viewport. It can only be turned off from the 
main setting. 

c. If the main setting is ON, then the inactive viewport will show red or blue without a checkmark. In this 
case the button is press-able and can be toggled on and off. 

 OR   

If the main setting is on, non-focus viewports can be toggled on and off 

 

8. When multiple viewports are displayed, each viewport may have an individual Z index setting. To set a Z index for 
a viewport, first click on the viewport to give it focus (it will have a blue title bar). Then run Orientation > Z Index. 
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The Z index for the focus viewport will show in the lower right corner of the Summit window next to the coordinate 
display. Repeat giving focus to any remaining viewports and setting their individual Z index values. 

 
Focus Viewport (blue title bar) showing an individual Z index (exaggerated for demonstration purposes) 

Note: Do not use Z Index to try to correct for coordinate system or geoid settings differences! If the correction 
requires a coordinate translation and you would like help applying it and using a Summit Solution project 
(combining projects with different input coordinate systems), please contact DAT/EM Support. 

 

9. When a multiple viewport is given Windows Focus (the title bar turns blue), all inactive viewports will be checked 
to see if they are Summit “Orthophoto Feature Collection” projects. If they are, then their display angle is changed 
to the active viewport’s angle. If the active viewport is an orthophoto project, then the display angle is set back to 
0.0 for all orthophoto views both active and inactive. Note that an inactive orthophoto project will match a non-
orthophoto project (such as an aerial project), but not vice versa. (September 18, 2019) 

10. Multiple Project Solution projects (.smtsln) are improved: 

a. Summit > File > Create Multiple Project Solution now automatically sets as many viewports as the 
number of projects you add to the solution file.  

b. The Automatically load next model settings for each viewport will be ON by default. This allows the 
different component projects to immediately synchronize their positions (if possible) to the focus 
viewport’s location. 

11. The zoom together icons that appear in the title bars of multiple viewports were not always reacting according to 
their colors (blue for on, red for off). This is fixed. (September 20, 2019 or earlier) 

12. Terrain Visualization’s minimized version of the dialog is a little bit bigger now so that the message text is not 
obscured by the dialog box title bar. (Oct. 24, 2019) 
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13. There is a new vector file “movie” player tool. It makes the Summit cursor move along a vector object, such as a 
polyline or polygon at a user-controlled speed and direction. (December 31, 2019) 

 
New vector “movie” player tool moves the cursor along an object 

a. Loads DXF or SHP 

b. Play and Pause 

c. Speed up or slow down 

d. Run forward or reverse 

e. Use the bottom duration slider to go anywhere on the “movie” 

f. Works with Terrain Following on or off 

g. The vectors do not display by the tool itself. Optionally load the DXF or SHP in DAT/EM Drawing Tools to 
show the lines. 

14. The Models at Cursor option on Summit’s Model Change toolbar has the following changes: 

 
a. Models at Cursor has a new Use Groups checkbox. If it is checked on and a model is open from a 

Group (available on the Project window’s Groups tab), then the dialog will only list other models from the 
same Group. If the setting is unchecked, all models at the cursor position will be displayed. (March 2, 2020) 

b. The Update button is new. If the dialog is already running when you change the model, model Group, 
project, options, or move the cursor, you can now use Update to refresh the list. (March 2, 2020) 

 
New Use Groups checkbox and Update button in Models at Cursor 
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c. Models at Cursor now updates the model next to the Single View button to match a model selected in 
the Models list above. When Single View is selected, the highlighted and displayed model opens in a 
single viewport. Previously, Single View would only leave the model open that was already open when 
the dialog started. (February 27, 2020) 

 
 

d. The Models at cursor dialog now saves and restores at its last-used screen position. (March 11, 2020) 

e. Models at Cursor now accesses the binary extents file when Summit > Orientation > Model Extents to 
File is active. (Note: Model Extents to File is used for faster response in large projects.) Previously, 
Models at Cursor always started its own search through all model extents to find the model intersections, 
which could be very slow in a large project. (March 2, 2020) 

15. The Camera Editor no longer gives multiple error messages when a required field is left blank. Instead, it will fill 
the empty field with a zero. As always, the user will need to make sure the camera file is correct.  (April 2, 2020) 

16. The Distortion Removal Tool was missing from the installation and the Summit Evolution Professional menus and 
has been restored.  (May 4, 2020) 

 

 
Terrain Project Tools (except Point Cloud) 

17. Terrain Projects and Terrain Project-related subjects (except Point Cloud) have the following changes. Note: Point 
Cloud application items have been moved to the next section. 

a. The installation process will set the Windows default application to DAT/EM Point Cloud for the .vrldr 
format. (May 17, 2019) 

b. Terrain Project Terrain Following’s “Show surrounding points” option would not clear the current points 
from the view when turned off. This is fixed. (January 31, 2020) 

c. Terrain Projects (.vrldr) may now be used as input for the aerial project’s Control Transfer tool. (July 26, 
2019) 

d. Terrain Projects (.vrldr) may now be used as input for the Create Terrain Project tool. This allows you to 
combine multiple Terrain Projects or add more points, for example from another LAS file, to an existing 
Terrain Project. (May 26, 2020) 
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e. Summit > Terrain > Link Terrain Project is new. It allows you to set a Terrain Project (TP) .vrldr to load 
automatically when the Summit project loads. In the dialog, the Terrain Project field will automatically fill 
with the currently linked or loaded TP if there is one. (April 6, 2020) 

   
Link a Terrain Project to load automatically in the Summit Project 

f. Terrain Project (TP) Terrain Following has a new Z filter tool located in Summit > Terrain > TP Filter Z. 
This is useful when there are multiple terrain points in the same general area from different features of 
different heights, and you want the cursor to follow only one of the features. Examples could include a 
bridge over a road below, a tall building adjoining a sidewalk, or tall vegetation points mixed in with points 
on the ground.  

Let’s say TP Terrain Following is on and you want the cursor to stay on a road below a bridge. You can 
set it to filter out points that are much different from the current elevation. Then when the area around the 
cursor has some points on the road below and some points on a bridge above, the cursor will not 
constantly “pop” up to the bridge and back down to the road. It will make a surface from only the points 
near the road elevation. 

There are two ways to filter the elevations. Either set Keep Z values from … and Above/Below or Filter 
outside Z range and enter a minimum and maximum elevation. The Z buttons fetch the current Summit 
elevation. It can be faster to set Summit to the elevation and fetch the Z value than to key in the value. 

 
New Terrain Project Terrain Following Z filter tool 

The values are always temporary. No dialog items are saved. Closing this dialog turns off filtering. This is 
by design. This is always a temporary state. 

g. Summit > Terrain > Stereo Mate from Orthophotos is a new tool to generate the stereo mate from an 
existing orthophoto and a Terrain Project. The major advantages over the old method (located in Summit 
> Imagery > Generate Stereo Mates) are much faster generation and no point filtering. (October 25, 2019) 

In one test, the Terrain Project version of the Stereo Mate from Orthophotos tool took 8 minutes to 
generate a stereo mate that took over an hour in the old version. 
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The executable for this application is actually the existing Terrain Project Lidargrammetry tool. It is run 
with a -mate startup flag from the Summit Terrain menu. The Lidargrammetry dialog does not offer user 
settings for the mode once it is running; it must be started with the -mate flag. 

Hints: 

 A desktop shortcut will not be made automatically for Lidargrammetry in stereo mate mode. If 
you want to create a shortcut, make it from this application, 

"C:\Program Files\Datem Software\LidargramUI.exe" 

and modify the shortcut Target to add the -mate flag: 

 
-mate flag to start Lidargrammetry stereo mate mode 

 If you want to generate more stereo mates at one time, start two instances of Lidargrammetry 
in the -mate mode. Add half the orthophotos to each. Do not start more than two instances, 
because they will not run faster and may even be slower than just two instances. 

To create stereo mates using existing orthophotos and Terrain Project input: 

 Use Summit > Terrain > Create Terrain Project to create a Terrain Project .vrldr file from 
the DEM/DTM input file(s). There is no limit to the number of input points. Keep in mind that 
the points should represent the highest object at any given (x,y) in the orthophotos. Do not 
generate the Terrain Project from “bare earth” points that are underneath trees and buildings, 
because this will give incorrect locations for the trees and buildings that appear in the 
orthophoto. 

 Start Summit > Terrain > Stereo Mate from Orthophotos: 

 Make settings in the dialog: 

Add one or more orthophotos by browsing or drag-and-drop method. (If planning to run 
two instances, add half the orthophotos.) 

Set the .vrldr Terrain Project made earlier. 

Choose a compression setting. If No compression is selected, it will automatically make 
BigTiff files if the file size goes over ~4.2GB. 

If Make Summit Project is set, it will make an .smtxml project from the resulting 
orthophotos and stereo mates. DAT/EM recommends to set this to “on”, but it can also be 
made later from Summit > File > New > Generated Stereo from Orthophotos. 

Set a Pixel shift.  

Hint: Generate just one stereo mate first using the default of 1. Then make test images 
using a pixel shift of 0.5, 2, and 3. Open each resulting project to see how you like the 
vertical exaggeration. After you choose the best setting, use it to generate the rest of the 
orthophotos (see image below). 
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The New Terrain Project version of Generate Stereo Mate 

h. Summit > Terrain > Create Terrain Project has a new Compress setting for Terrain Project file 
compression. Compression is optional, but recommended for most projects. It is on by default. 

In a DAT/EM test, a Terrain Project with 3 billion points went from 211 GB to 50 GB; you can expect most 
projects will get around 5 to 1 compression. 

Zip compression is used to store all the octree data in one gigantic .zip file. The information inside is read 
directly from DAT/EM software straight out of the .zip. This has advantages, since large, uncompressed 
projects can have many thousands of files within the Windows file system. Although decompression can 
be slower than reading an uncompressed file, this slowdown is greatly offset by the increased speed of 
reading only one file instead of many separate files. 

DAT/EM software will automatically read either compressed or non-compressed projects. Terrain Projects 
generated with older versions will still work, but of course you have the option of regenerating them with 
the Compress setting on. (May 22, 2019) 

 
Terrain Project compression setting 
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i. Terrain Project (TP) Terrain Following and the older Terrain Following share the tool to activate and 
deactivate following the elevation of the surface. Previously, the following on/off icon on their separate 
toolbars would activate or deactivate together. They will now activate only on the toolbar for the type of 
terrain tools you’re actively using, based on the type of terrain file or Terrain Project you have loaded. (July 
26, 2019) 

j. There is a new Terrain Project Options dialog where you can adjust the Terrain Project Show TP 
Surrounding Points settings, including color, size, style, and an option to change the default square 
display area into a circle with a set Clip radius: (March 27, 2020) 

   
New Terrain Project Options control the Show TP Surrounding Points display 

 
Point Cloud Application 

18. Point Cloud has the following changes: 

a. The installation process will set the Windows default application to DAT/EM Point Cloud for the .vrldr 
format. (May 17, 2019) 

b. Point Cloud > File > New will now correctly launch the Terrain Project generator application. (Dec. 9, 2019) 

c. Point Cloud has a new Generic CAD toolbar added to its user interface. These tools allow you start CAD 
commands in the Capture that is running (AutoCAD, MicroStation, or ArcGIS). It is similar to Summit’s 
CAD toolbar. If you hover the system mouse over a tool, the resulting tooltip will describe the tool’s 
function. (December 9, 2019) 

 
New CAD toolbar in Point Cloud 

d. Point Cloud has a new Tools toolbar and pull-down menu. Descriptions of the tools offered on it are 
shown in the sections below. 

 
Point Cloud’s new Tools toolbar and menu 
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e. Point Cloud has a new Mesh View tool that lets you make a filled 3D TIN in the area of the view, like this: 
(December 9, 2019) 

 

 
New Point Cloud Mesh View tool 

• It defaults to 50,000 just for a quick mesh. 

• In the example above, the whole view is around 500,000 points and can take longer to 
render. 

• It can be canceled by closing the Mesh View dialog. 

• This would be the recommended use if a mesh is wanted. Meshing can be done in 
preprocess (by checking on Create Mesh when generating the .vrldr), but it allows no 
options and meshes are processed in grid areas. 

• The Neighbors option is for filling gaps. A larger number will fill in larger gaps between 
points (5-300). 

f. Point Cloud has new Measure and Measure Mean tools on the Tools toolbar and menu. These allow 
you to make measurements in the Point Cloud view area and to see various statistics listed for the 
measurements.  (February 19, 2020) 

g. Point Cloud can now follow along with Summit’s cursor. Select Tools > Follow Summit to allow Summit 
to control Point Cloud’s position. This is useful when you have a Summit Evolution project open in the 
same area as the Point Cloud .vrldr file. The .vrldr points must be in the same coordinate system as the 
Summit’s project. (February 19, 2020) 

 
Make Point Cloud follow Summit’s cursor position 
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h. Point Cloud can now move to Summit’s current position. Summit must be running with a project loaded 
and oriented in the same area and coordinate system as the currently loaded Point Cloud Terrain Project. 
Select Tools > Move Summit. The Point Cloud cursor will jump to Summit’s ground coordinate. 

 
Move Point Cloud to Summit’s cursor position 

i. Point Cloud has a new, experimental Measure Tree Volume tool. It is intended for measuring the volume 
of a symmetrical tree, such as an evenly growing spruce tree. You measure two points for one diameter 
(for example at the base of the tree) and another two points for a second diameter (for example at the top 
of the tree).  The centers of the two lines are used to get a height.  It uses a volume calculation of volume 
= ((PI * height) * (D1*D1 + D2 * D2 + D1 * D2)) / 12.0;  reference 
https://en.wikipedia.org/wiki/Tree_volume_measurement . User feedback to support@datem.com is 
highly encouraged. (February 19, 2020) 

 
Summit’s experimental Measure Tree Volume tool 

j. Point Cloud has a new dialog tool for locking the view and cursor. This may be used, for example, to lock 
the cursor to a set height above the ground in order to measure tree diameters. (February 19, 2020) 

k. Point Cloud has new cursor ground rings. (February 19, 2020) 

l. Point Cloud now has three point size (display) methods: Relative, Absolute, and Pixel: (February 19, 2020) 

• Relative bases the size on the average distance between points. This should result in a 
consistent size for close range as well high aerial. This will only work well with newly generated 
projects since the density is much more accurate now. If Relative does not work, then try the 
Absolute size. 

• Absolute lets you input the actual size of the point in ground distance. For example, for a close- 
range project in metric units, you might set this to a size of a centimeter, .001, but for a high 
altitude project, you might use a meter, 1.0, or more. 

• Pixel makes every point the same size in screen pixels no matter how far or how close the 
viewpoint is to the point. This is the same way that DAT/EM LandScape shows points. 

m. If Summit had already loaded the .vrldr and was still running when Point Cloud started, Point Cloud would 
not load a .vrldr file. Likewise, if Point Cloud had already loaded the .vrldr file, Summit could load the 
same file, but would not follow terrain or show surrounding points. The two applications, Summit and 
Point Cloud, would need to run at different times in order to load and use .vrldr files properly. This is fixed.  
(May 20, 2019) 

n. Point Cloud was not working with DAT/EM Capture for AutoCAD, MicroStation, ArcMap, or Global 
Mapper (CAD/GIS) in v.7.6. It was not setting the model extents in CAD/GIS. (May 30, 2019) 

There are projects where you might want to use Point Cloud and Summit at the same time; however, 
there was some question about which application should “talk” to DAT/EM Capture and control digitizing 
in CAD/GIS. If you intend to use both Summit and Point Cloud at the same time along with Capture, do 
the following: 

 Start Summit first and load a model or image that gives ground coordinates. 

 Start AutoCAD, MicroStation, ArcGIS, or Global Mapper (CAD/GIS) next. 

 Start Point Cloud last. 

 If you want to change projects, close all applications and restart them by loading the new 
project in the Summit, CAD/GIS, Point Cloud order again. 

https://en.wikipedia.org/wiki/Tree_volume_measurement
mailto:support@datem.com
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When Point Cloud starts, it will check whether Summit is running. If Summit is running, Point Cloud will 
not send model extents to CAD/GIS. It will only initiate control of Capture for CAD/GIS when Summit is 
not already running. 

If you accidentally start them in the wrong order, close all three applications and start again in the proper 
order: Summit, CAD/GIS, Point Cloud. 

AutoCAD users: If you are using Capture for AutoCAD and you start Summit, AutoCAD, and Point Cloud 
in the proper order, but you still don’t see the cursor moving in AutoCAD when you move the Summit 
cursor, key in the ORIENT command in AutoCAD’s command line. 

o. Point Cloud has superimposition improvements: (December 9, 2019) 

• SI command text will now display in the upper corner 

• SI menu and toolbar. “SI Update” and “SI layer manager” added 

• Stipple lines via shader 

• Circle and Arc type support 

• Holes in filled surfaces 

• Line Width support 

• Line Mitering via shader 

• Glow effects improvements 

p. Point Cloud’s “Movement mode” has improved to better match other 3D packages and video games. 
Movement keys and the system mouse are enabled whenever the view is active. Previously, these only 
activated on right-click and when “movement mode” was selected. (December 9, 2019) 

• The wheel now moves the view FORWARD and BACK (previously it was UP and 
DOWN). 

• Hold the wheel button to perform an UP-DOWN and LEFT-RIGHT pan (previously 
holding the wheel button was not used). 

• Right Click will still enter “movement mode”. This locks the mouse to the view so it can be 
in ORBIT mode (mouse used to rotate the view). 

q. Point Cloud has a new .vrldr project overview tool. (December 10, 2019) 

 
New overview tool in Point Cloud 
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Superimposition 

19. Superimposition (SI) has the following changes: 

a. Summit’s Layer Manager “Checked” layers would prevent the Capture for ArcGIS temporary graphics 
from displaying in SI. That is, an in-progress line or polygon drawing would not be visible in SI; it would 
have to be finished before it would display if it was on a checked layer. The temporary graphics will now 
always display. (July 29, 2019) 

b. SI in Summit’s 3D Vector Split Window had a display error for multiple sources of SI. For example, if 
CAD/GIS and the SI Lidar Tool were both running, one would display in the correct location and the other 
would seem as if it had been pushed away to the background of the 3D Vector Split Window view. This is 
fixed so that any number of SI sources will display correctly.  (October 14, 2019) 

c. The surrounding points display for Terrain Following and Terrain Project Terrain Following will now 
display in any 3D SI window, such as the 3DVector Split Window.  (October 17, 2019) 

d. Superimposition (SI) in Summit now has an SI override tool in Summit > SI > SI View Override.  

    
The user can change the size and color of points and line work for any layer and from any SI source (or 
instance). The values are saved to the registry, so they will persist. For example, if the user changes the 
color or size of points coming from Landscape, they will stay that way until the override is removed. The 
‘Remove All’ button will remove every override from every source, making it a quick way to reset all colors 
to the colors in the CAD/GIS/LandScape/SI source.  

e. Superimposition can now display different point sizes (widths); however, this depends on the Capture 
product sending a width along with the point coordinate to superimposition: (March 23, 2020 for AutoCAD and 
ArcGIS; March 31, 2020 for MicroStation, changes to MicroStation April 28, 2019.) 

For MicroStation to send the point width to superimposition, set the custom width attribute or ByLevel 
width attribute for the zero-length line or line string. To display the width, check on the MicroStation-side 
SI SETTINGS > Show Line Weight setting. The Summit-side Tools > Options > SI tab > Points size may 
be a factor of the width as well. To turn off the setting, turn off SI SETTINGS > Show Line Weight, so 
that it returns to the size set in the Summit-side setting without factoring the MicroStation line weight.  
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For ArcGIS to send the point width to superimposition, you must set the point Type=Simple Marker 
Symbol (see below) and then set the Size. At this time, this is the only supported type; other types will 
continue to display as a default-sized point “dot” in superimposition. (March 23 and 25, 2020) 

 
Simple Marker Symbol and Size in ArcMap’s point geometry properties 

For AutoCAD to send the point width to superimposition, you must set the Thickness for one or more 
selected points in AutoCAD’s Point Properties: 

 
Point Properties Thickness setting in AutoCAD applies to one or more selected points 
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Aerial Projects (large format aerial frame and UAS imagery) 

20. Aerial projects (large format aerial frame and UAS imagery) have the following changes: 

a. With an Absolute Orientation (AO) active, if the Project Edit dialog’s Interior Corrections were set to have 
Earth Curvature and Atmospheric Corrections on with either Use Heights or Dynamic Terrain… on, it 
would apply a too-large correction. This is fixed. (July 24, 2019) 

b. The Control Transfer tool can now read Terrain Project format as an input format. (July 26, 2019) 

c. JPG images, which are often used for UAS imagery, can now be used directly by Summit. 

• Summit will generate the zoom levels for JPG format on the fly if necessary; some UAS JPGs 
have zoom levels in them, others don’t. 

• JPGs are slower to use than TIFs. Older, slower computers may still need to generate TIFs using 
DAT/EM Image Creator, especially if response is too slow with the JPGs. 

• If you run into any problems with either speed or display, you may still need to use Image Creator 
to generate TIFs and replace the JPGs in the project. If the display is a problem, please send an 
example of the images to support@datem.com.  

d. The Interior Orientation (IO), Relative Orientation (RO), and Tie Points Relative Orientation (Tie) dialogs 
now offer a new left-pick system mouse measurement method. This applies to IO’s single-image display 
and RO and Tie’s side-by-side displays. (September 30, 2019) 

In the mentioned dialogs, the left-pick system mouse measurement can be used as an alternative to 
measuring with the 3D input device. Measurement with the 3D input device is still available and has not 
changed. 

With the left-pick system mouse method, simply pick directly with the left button of the system mouse on 
the same object in the single image (IO) or left and right side-by-side (RO and Tie) views. This will make a 
measurement in the left and/or right image, as long as the image is unlocked for measurement. 

The Align function (located on the Alignment toolbar or a button) may be used to help refine the 
measurement after an initial measurement with the system mouse. Align will replace the mouse-clicked 
measurement in the left and/or right image as long as that image is unlocked for measurement. (updates to 
the beta functionality November 6, 2019) 

 
Satellite RPC Projects 

21. Satellite RPC projects have the following changes: 

a. There is a new left-pick system mouse measurement method for the Satellite RPC Tie Points dialog when 
it is in side-by-side measurement model.  (September 30, 2019) 

The left-pick system mouse measurement can be used as an alternative to measuring with the 3D input 
device. Measurement with the 3D input device is still available and has not changed. 

With the left-pick system mouse method, simply pick directly with the system mouse on the same object 
in the left and right (side-by-side) views. This will make a measurement in the left and/or right image, as 
long as the image is unlocked for measurement. 

The Align function (located on the Alignment toolbar or a button) may be used to help refine the 
measurement after an initial measurement with the system mouse. Align will replace the mouse-clicked 
measurement in the left and/or right image as long as that image is unlocked for measurement. (updates to 
the beta functionality November 6, 2019) 

b. Satellite RPC projects in Ortho+Mosaic would not generate orthophotos if individual image boundaries 
were not present. Now the individual image boundaries are optional, and orthophotos will generate 
whether they are there or not. (October 21, 2019) 

c. Satellite RPC projects in Ortho+Mosaic will now properly generate “Individual Image Boundaries”. 
Previously, no boundaries would generate for this project type. (October 21, 2019) 

mailto:support@datem.com
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ADS40/80/100 Projects 

22. ADS40/80/100 (ADS) projects have the following changes: 

a. The project editor (Summit > Edit > Project) for ADS projects has a setting called Combine split imagery 
blocks. If this checkbox was off the first time the project editor was closed and the project was saved, it 
would always stay off in the XML code in the project file. It could not be changed by checking the option on 
in a subsequent run of the project editor. This had the downstream effect of preventing the automatic model 
generator from being able to make combined block models. This is fixed. (May 14, 2020) 

b. The Summit > Edit > Project > Add button starts a browse dialog that now allows multiple ADS image 
selections instead of just one image at a time. (May 14, 2020) 

 
Imported Projects 

23. Imported Projects have the following change: 

The Summit > Import > Pix4D option will now proceed to import the project when only JPG images are 
found. Previously, the import process required a TIF version of the images, usually made by DAT/EM 
Image Creator. This change takes advantage of the new v.7.7 ability to read JPG images directly and 
make zoom levels on the fly. See more information in item 20.c. on page 25. (May 12, 2020) 

 
Button Manager 

24. Button Manager has the following change: 

A tooltip showing the entire Action setting will appear if you hover the system mouse cursor over the 
Action line. (May 18, 2020) 

 
Image Creator 

25. Image Creator and other image-reading applications have the following changes: 

a. Image Creator’s “Image Information” dialog will now show the orientation of the image, if available. For 
example, it might show, “Top Left” for a top-left-oriented image. (Oct. 14, 2019) 

b. An old 32-bit pointer bug was fixed. This could cause Image Creator to crash in v.7.7 betas built after 
DAT/EM upgraded to Visual C 2017. The bug was present, but did not cause crashing, in early 7.7 betas, 
v.7.6, and other earlier versions.  (December 18, 2019) 

c. Image Creator and some other image-reading DAT/EM software can now read .MRF (Meta Raster 
Format) files and other image formats supported by GDAL version 3.0. GDAL is a translator library for 
raster and vector geospatial data formats that is released under an X/MIT style Open Source License by 
the Open Source Geospatial Foundation. 

MRF format can be used directly in Summit without converting to another format. Although the DAT/EM 
Image Creator can convert them to a TIF or JP2, there is usually no need to do so.  

Since GDAL supports some formats that DAT/EM software could already read, Image Creator will first try 
the preexisting readers; if the format is not supported with preexisting readers, then it will try the GDAL 
formats. The only extension that was specifically added to the Image Creator browse dialog’s extensions 
list (display) was MRF, because that is the only format for which we have a sample, so it is the only 
format we can be sure works at this time. However, you can browse “all files” with other extensions to see 
if the GDAL reader will accept them. (January 6, 2020) 
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Point Translator (and point manager code) 

26. Point Translator and the point manager code used by several DAT/EM applications to read terrain point files have 
the following changes: 

a. LAS files that have a complete header, but zero points, could cause the point manager code to crash. 
Now LAS files with zero points will be ignored. (December 26, 2019) 

b. LAS files that have an incomplete header will be moved to a “dead file” list and will be ignored. (December 
26, 2019) 

c. Point Translator was making an invalid LAS file from ASCII xyz input. This is fixed. (March 10, 2020) 

 

 
Project Viewer / Ortho+Mosaic  

27. Project Viewer / Ortho+Mosaic has the following changes: 

a. Satellite RPC projects in Ortho+Mosaic would not generate orthophotos if individual image boundaries 
were not present. Now the individual image boundaries are optional, and orthophotos will generate 
whether they are there or not. (October 21, 2019) 

b. Satellite RPC projects in DAT/EM Ortho+Mosaic will now properly generate “Individual Image 
Boundaries”. Previously, no boundaries would generate for this project type. (October 21, 2019) 

c. Ortho+Mosaic may write a “Coordinate System” description into the header of the orthophoto and mosaic 
images in the following cases: (December 26, 2019) 

 If the original raw images (in a Summit aerial project, for example) have a “Coordinate system” 
entry in their image header. Note: This is the highest priority system, and will not take into 
account any project coordinate system conversion that might be set in Summit > Orientation > 
Coordinate Conversion. If the image header lists a coordinate system, do not apply a coordinate 
system conversion in Summit before making orthophotos. Check Image Information to be sure. 

 If there is not a “Coordinate system” entry in the raw images’ header, but there is an input system 
set in Summit > Orientation > Coordinate Conversion with coordinate conversion unchecked. 

 If there is not a “Coordinate system” entry in the raw images’ header, but both input and output 
systems are set with coordinate conversion checked on in Summit > Orientation > Coordinate 
Conversion. 

Note: This may be a reason to set at least an input system in Summit > Orientation > Coordinate 
Conversion. When there is a coordinate system set in an orthophoto/mosaic, applications such as 
ArcGIS and Global Mapper can display them in different coordinate systems if set to do so. 
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LandScape 
LandScape has the following changes: 

1. The Profile Side View is new. It is a 90º rotation of the profile view that is only available when the profile window is 

open. The toolbar button is . It will work for viewing, selecting, and editing points. (May 20, 2019) 

 
 

2. Some errors were found in LandScape processing. Fixes for 7.7 include edits saving approximately five times 
faster and breakline editing running approximately two times faster. Fixes were included in the betas after June 
25, 2019 and in a v.7.6 patch available on www.datem.com. (June 25, 2019) 

3. It was possible for the Selection Set to fail in the  (batch) tools. This is fixed and was 
added to v.7.7 beta and to a patch for v.7.6 (available on www.datem.com) (July 8, 2019) 

4. This was done for v.7.6, but was omitted from the v.7.6 Release Notes. The maximum allowed value for 
LandScape’s Options > Surface > Maximum points to cache setting has been increased to 40 million. (2019) 

5. GeoTiff DEM format can now both read and write from LandScape. This enables LandScape to edit GeoTiff DEM 
files. The list of editable formats is now: LAS, LAZ, BIN, SDTM, ASC, BIL, PIX, and now TIF.  (August 15, 2019) 

6. LandScape has a new tool to zoom to currently selected points. First select the points using any of the point 
selection methods, then select Zoom to selected LIDAR points from the toolbars. (August 28, 2019) 

 
LandScape can zoom to currently selected points 

 
 

http://www.datem.com/
http://www.datem.com/
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7. Pan Smoothly has been added to the LandScape > Tools > Options > Surface tab.  Together with this, the 
Maximum points to cache limit has been increased to 200 million. The more you load, the slower some 
operations become, but viewing and panning should be fast, even at 200 million. The speed no longer depends 
on the Pan Smoothly setting.  (August 19, 2019) 

 
New LandScape Pan Smoothly setting 

8. LandScape wasn’t refreshing the “Zoom Extents” view size after adding more input files and loading their points. 
The “Zoom Fit” toolbar item would only zoom to fit the previously existing files. These issues are fixed so that it 
uses the new, combined points’ extents. (August 19, 2019) 

9. LandScape has new view adjustment possibilities using keyboard input: (January 14, 2020) 

• +/- buttons on the number pad – Adjust the scale in LandScape’s main view 

• <CTRL> R – Reset the main view scale 

• <CTRL> +/- buttons on the number pad – Adjust the scale in LandScape’s profile view  

• <Ctrl><Shift>R – Reset the profile view scale  
 
 

10. Vertical Scale is a new dialog that allows the user to change the vertical exaggeration of the Main and Profile 
Views.  (January 10, 2020) 
 

• Values above the mid-point of the sliders increase the exaggeration 
• Values below the mid-point decrease the exaggeration. 

• The Reset buttons  set the values back to their defaults. 
 

 
New Vertical Scale settings 
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See the new Vertical Scale Settings menu for key-ins that may be used to modify vertical scales: 

 

 
New Vertical Scale Settings menu 

 
 

11. LandScape has a fix that prevents a crash when opening a .lndscp file that contains a point file reference, but 
doesn’t contain information about the point file, such as number of points. DAT/EM Point Translator outputs such 
a project file. The project file itself is not wrong; LandScape is supposed to get the information if it is not found in 
the project, and now this process will work better.  (April 22, 2020) 
 

12. When ‘Rotate View’ was active, the LandScape input device would not draw. This is fixed.  (May 6, 2020) 

 

DAT/EM Capture for ArcGIS - ArcMap 
This version is compatible with ArcGIS 10.0 (service pack 4), 10.1 (service pack 1), 10.2, 10.2.1, 10.2.2, 10.3, 10.3.1, 10.4.x, 10.5.x, 
10.6.x, 10.7.x, and 10.8 (plus any available service packs as they are released). 

This version may be compatible with ArcGIS 9.1, 9.2, 9.3 (service pack 1), 9.3.1(service pack 2). BE ADVISED: Testing no longer 
occurs for DAT/EM Capture with ArcGIS 9.x. It still installs for it and no code has been removed, so you may use 9.x as long as it 
continues to work for you. Any issues will not be corrected. ArcGIS 9.x support may be dropped completely in a future release. Please 
continue to make plans to upgrade any remaining ArcGIS 9.x version to 10.x. 

DAT/EM Capture for ArcGIS has the following changes: 
Capture for ArcGIS Items 

1. DAT/EM v.7.6 would cause ArcMap to crash if you drew an object on a layer that was nested (such as group 
layers or multilayers) in the ArcMap Table of Contents. This was fixed for v.7.7 and also provided as a patch for 
v.7.6.  (May 29, 2019) 

2. Zoom Summit to Selected  is a new tool to zoom Summit’s main view to the location and size of one or more 
selected objects’ extents. An additional 25% is given to the Summit view for a more comfortable view size.  To 
use, first select an object, then select the tool on the toolbar, Keypad, or Summit button. (May 29, Nov. 4, 2019) 

 
The keyword to use on the DAT/EM Keypad or on a Summit button is: 

ZoomSummitToSelected 

Note that the view size success may depend on the kappa angle of the current Summit model and the relative 
view length to width ratios of the Summit and ArcMap views. If you have trouble with the relative view sizes, 
please send a screen capture of both the Summit and ArcMap windows to DAT/EM Support. 
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3. Snap to object Z is a new snap mode that uses the elevation from the snapped-to object and the (x,y) from the 
stereoplotter’s cursor. Since the snapped locations are not guaranteed to be on an object, it can’t be used as part 
of a routine that performs selection, including the Modify tools. It will become disabled when the Task (shown on 
the DAT/EM Capture Drawing Tools toolbar) is set to Modify.  (May 18, 2020) 

The keyword to activate Snap to object Z from the DAT/EM Keypad Controller or a digitizer button is: 

snapz 

The icon on the DAT/EM Capture Drawing Tools toolbar is next to the 2D and 3D snap:  

This snap may be useful to digitize an object that is the same elevation, but a different (x,y) than a nearby object. 
Examples might be matching elevations of an existing riverbank as you digitize the other bank, or digitizing the 
other side of a trail or narrow road based on the elevation of the existing side. In these cases, you would need to 
set the snap radius large enough to reach the other side of the river, trail, or road, and turn on Classic Snapping 
for the river, trail, or road. 

 

4. Snap to object Z works with the DAT/EM Systems Options’ Snap > Drive stereoplotter following pick and 
Insert vertices into snapped objects. If Insert vertices… is on, the snapped-to object will gain a vertex at its 
original elevation and the new object’s stereoplotter cursor (x,y). If this is not desired, uncheck the setting in 
DAT/EM Systems Options Snap settings. 

 

5. The SI Drape tool had a hard limit of 1 million points, after which it would filter points in the input file(s). This has 
been increased to 4 million. SI Drape tries to evenly distribute points. If more than 4 million points are in the DEM 
file(s), it will skip every “nth” point to attempt to filter evenly until it has 4 million points loaded.  (August 13, 2019) 

6. The Visit tool has the following changes: (November 4, 2019) 

a. The meaning of Visit’s Vertices off setting has changed. Previously, it would move to the center of mass 
of the object. Now it will go to the first vertex. This will help in areas of multiple object candidates where it 
is difficult to tell which object belongs to the center of gravity point. 

b. The point table has a new column titled Viewed. An item will show as viewed after going to its coordinate 
in the Visit session. 

7. Objects with incorrect ring ordering (for example, an interior ring that doesn’t have an exterior ring associated with 
it) will now display in superimposition. Please note that just because it now displays, it should still be investigated 
and fixed, if possible. Investigate and attempt to fix the problem with ArcToolbox > Data Management Tools > 
Features > Check Geometry and Repair Geometry. (October 7, 2019) 

 
ArcToolbox Check Geometry report for “incorrect ring ordering” 
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8. Face Shift is a new tool in Capture for ArcGIS. It shifts ArcMap Point type elevations to match the elevation of a 
surface generated from the vertices of one or more polygons. (November 20, 2019) 

 
New Face Shift tool in Capture for ArcGIS 

Face Shift dialog options: 

• Layer to edit identifies the point layer containing the points to be edited. Face Shift only works on 
Point-geometry layers, not MultiPoint or ASC layer types. Note: After editing the Layer to edit, 
Face Shift will attempt to reactivate any layer selection that was active in the Create Features 
pane at the time Face Shift started. 

• If Use existing boundaries on layer is checked, then all the polygons on the polygon layer 
identified below it will be used to identify points to be edited. Any point contained by a polygon in 
that layer is a candidate for editing. If Use existing boundaries on layer is not checked, then the 
user may draw a polygon using either Summit’s cursor or the system mouse. 

• Use surface Z values may be used to temporarily set the z values of the boundaries to the 
elevations of the surrounding points before this shift occurs.  This can be helpful when flattening 
areas of points to match the neighboring points. If the system mouse is used to collect the 
boundary this method will always be used even if the box is not checked. 

• If the Tolerance value is not set to 0, then points with z values less than the tolerance distance 
away from the new z value will not be modified. 

• Copy then shift provides the ability to store the original points in either an existing layer in the 
drawing or a new shapefile. 

• The Status window list provides information about the results of the shift. 

The command ID to activate Face Shift on the DAT/EM Keypad or on a Summit button is: 

Call Command CaptureArcInfo.FaceShift 
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9. This was added in version 7.6, but was omitted from the 7.6 Release Notes. The DAT/EM Fill Polygons tool has a 
new setting to optionally copy field values from the selected polygon into the new polygon. If the new polygon is 
on a different layer that has a different list of fields, only those fields that match will be copied. To use, first check 
on the Copy field values option from the ArcMap-side DAT/EM Systems Options Polygon Fill setting: (April 16, 
2019, in version 7.6) 

  
Then activate the Fill Polygons tool: 

 

 
10. Version 7.6 with the ArcMap-side DAT/EM Options SI Clip setting on could be just as slow as having the setting 

off. This was due to fetching the clip bounds before they were available, which updated all possible SI objects 
instead of clipping. The SI clip bounds will now be fetched at the right time after a model loads. (October. 3, 2019) 

11. In previous versions, using the “LoadSnapState <snap state name>” command from the DAT/EM Keypad or a 
digitizer button during drawing with Capture for ArcGIS tools would cause unintentional results. For example, the 
line you were drawing might end, the task might change to Modify, and the Insert Vertex command might activate, 
while the intended behavior would be to change the snap states and continue drawing the in-progress sketch. 
This is fixed, so it is now possible to change the saved snap states during drawing. Note: Saved snap states are 
made in the ArcMap-side DAT/EM Capture Options and loading them affects the checkbox states in the Classic 
Snapping Environment. (November 26, 2019) 
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12. There were cases when ArcMap would lock Summit out of performing a data view rotation to match Summit’s 
kappa angle, which Summit tries to do as it starts and loads a model. If the rotation failed at startup, then 
subsequent model changes would also fail to set the data view rotation. Now it uses a different method to force 
the view rotation. (November 26, 2019) 

13. It was possible for the point-to-point drawing tool to add two points instead of one when collecting points by 
picking a snapped location with Classic Snapping and DAT/EM Snap 2D or 3D on. This is fixed so that it only 
adds one point per pick with snapping on. (April 3, 2020) 

14. Superimposition can now display different point sizes for points set to Type=Simple Marker Symbol and the Size 
setting (see below). At this time, this is the only supported type; other types will continue to display as a default-
sized point “dot” in superimposition. (March 23 and 25, 2020) 

 
Simple Marker Symbol and Size in ArcMap’s point geometry properties 

 
Airfield3D 

15. Airfield3D has the following changes: 

a. The Recalculate Tools did not always successfully update the Group Code field for the Obstacles inside 
ObstructionArea polygons. Users also found it confusing to have a separate checkbox to update the 
ObstructionAreas’ Group Code field, especially since there’s no time when this task should not be done.  

• The Update ObstructionArea Group Code checkbox has been removed and the functionality 
added to the Obstacle recalculation settings. 

• Now when Group Code is set to “Recalculate” or “Recalculate if not set”, the ObstructionAreas’ 
Group Code fields will first update to be sure they are the same as each polygon’s unique Object 
ID. Then for each Obstacle located inside an ObstructionArea polygon, the Obstacle’s Group 
Code field will update to match its enclosing polygon. 

• If an Obstacle is contained in more than one ObstructionArea polygon, its Group Code will be set 
to match the last-processed polygon. (June 12, 2019) 
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Update ObstructionArea Group Code functionality moved to the Obstacle recalculation settings 

 

b. In a Vertically Guided setup, it was possible for the VGAS and VGAPS on one side of the runway to 
generate the far end at 505 feet higher than the wrong runway end. This could make the slope of the 
surfaces wrong on the side that had the higher runway endpoint, since they did not rise from the nearer 
runway end elevation. Whether it happened or not depended on a certain configuration of the center line 
direction or bearing and the elevation of the runway ends. It would not happen on every runway, and 
those affected would have surfaces too low on one end. (October 29, 2019) 

The problem was in Airfield3D since 18 April 2012, but there was a change on 6 September 2017 that 
would have affected how it behaved. 

Before 6 September 2017, the runways that were affected had a runway centerline vertex order from high 
end to low end. That is, the higher end was the first centerline vertex, and the lower end was the last 
vertex. In this case, the surfaces generated on the high end would have been too low. 

After 6 September 2017, centerline vertex order was automatically aligned to the heading, so vertex order 
no longer mattered, but the runway angle (heading, or lower number painted on the end of the runway) 
did matter. The automatically rearranged ‘start vertex’ would be the lower runway angle and automatic 
‘end vertex’ would be the higher runway angle. Note that this may or may not match the high or low 
runway elevation. If the higher elevation was at the lower heading, it would have generated the surfaces 
too low on the high end. If the lower elevation was at the lower heading, all surfaces would have been 
correct. 

Surfaces for the affected runway ends would have always been low, never high. This would result in 
possibly too many obstacles being identified on the high end of affected runways, the surface lines written 
to ArcMap for the high end of the runway having an incorrect elevation, and the obstacle penetration 
values being off. The amount they were off depended on the elevation difference between the runway 
endpoints. 
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c. The Height Above Touchdown Zone elevation field was not being populated for an obstacle due to a 
mistake in looking for the runway end name. This is fixed. If it was missed in existing data, use the 
Recalculate tool to populate the field values.  (January 30, 2020) 

 
Height Above Touchdown Zone field is now being populated 

d. The functionality of the Summit-side Airspace Z offset has been expanded. Now it will apply whether or 
not surface locking is on. When locking is on, it will operate as before. When locking is off, it will now 
affect the “above” and “below” indicators, including the cursor design, heads-up text, and indicators. They 
will change to indicate the offset elevation from the surface instead of the surface itself. Note that the 
actual surface does not change; it only changes the behavior of the indicators.  (October 29, 2019) 

 

   
Airfield3D head’s up text shows whether there’s an active offset 

e. A new dividing line has been added in superimposition and can be exported to the dividing lines shapefile 
(see item below). It draws between the “within 10200’ of threshold” and the “>10200 to 20200’ from 
threshold” in the VGAS. (On or before November 4, 2019) 

f. All dividing lines (including the new one mentioned above) that show up in superimposition, but are not 
defined surface polygons, can now be exported to ArcGIS line-geometry shapefiles. The shapefiles may 
be added to the current .mxd.  (October 31, 2019) 

g. The Height above ground measurement (activated by Airfield3D Apply for an Obstacle point) previously 
was always on for man-made objects and optional for natural objects in the FAA’s 2010-era template. 
Now this measurement is optional, that is, it can be turned off so that Apply does not produce a prompt to 
measure the height above ground value. This may be necessary in custom templates or non-FAA-type 
work where the user does not wish to manually measure the height above ground field at all. (Nov. 4, 2019) 
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The setting is located in the Options to the right of the FAA 18b setting in the lower edge of the Airfield3D 
dialog: 

  
FAA 18B options button on the lower edge of the Airfield3D dialog (left)  

New “Measure Above Ground Level” setting for FAA 18b configurations (right) 

h. The Measure Status (stoplight) tool will now consistently update its list on a pick to digitize a new 
obstacle. Previously, it would wait until an Apply was received to update the list. This change further 
enables you to run Measure Status during the digitizing process to keep an eye on the effects of adding 
more obstacles. (On or before November 4, 2019) 

i. There are new Approach Middle Width settings for custom Part 77 runway end definitions. These can 
be used to control the "waist" of the approach, that is, the width of the surface where the “Approach slope 
change distance” ends and transitions to the second slope. A setting of 0 (zero) will cause it to return to 
the default value. (February 24, 2020) 
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Below is an example with an exaggerated value on one end. Notice how the end with the middle width of 
1500 is much wider than the other end that has 700. 

 
j. For FAA Part77 Custom end definitions, there is a new option to select any of the standard Part77 ends 

as a template. An example of a standard end is “Non-Precision Large (Greater than ¾ mile)”. After 
selecting one of the standard ends as a template, you may either leave it in its original configuration or 
further customize its values. 

To use this new option, perform the steps shown in the graphics below: 

 
Step 1: Set FAA Part77 Custom and select the options button to the right of it. 
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Step 2: Select Define Runways to open Part77 Custom Runway Ends 

 

 
Step 3: To start a new end definition, select the options button under the Runway End list. From 
the pull-down menu that initially shows Default, select any of the standard Part77 templates. 
Select the green + button to add the end using the selected template. Double click the new end 
and change its Name. If changes are necessary, double click any of the values and modify them. 
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k. The One Engine Inoperative (OEI) surfaces were being calculated flat from the end of the runway 
according to the description (or lack thereof!) in the Advisory Circular 150/5300-18B (original and Change 
1, “18B”), which does not mention elevation. A customer requested that they be sloped according to the 
more detailed description in Advisory Circular 150/5300-13, Change 9 (“13, change 9”), which defines a 
62.5:1 slope in the first 50,000 feet as follows: (January 9, 2020) 

 
Despite the fact that Airfield3D is based on the 18B, we decided to add the slope to the OEI that starts at 
the end of the runway according to the 13, change 9. The slope is set to 62:5:1 for the first 50,000 feet, 
for a grand total rise of 800 feet. Note: Airfield3D only calculates this surface from the end of the runway; 
it does not contain code to detect or build the OEI from the end of the clearway. 

The main reason for the decision was that the flat OEI defined in the 18B is unusable in every 
conceivable way except for 2D paper plots. Airfield3D works in stereo, where a flat OEI surface might 
even be under the ground in the stereo view. It simply does not make sense to have a completely flat 
OEI; leaving out the slope definition seems to be a mistake in the 18B. 

l. The Reports tool will now output the second-highest point as well as the highest point for the NVGAS. 
(May 8, 2020) 
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m. The NVGATS now has the 10 individual surfaces that need to be reported: 2 Type 1 surfaces, 4 Type 2 
surfaces, and 4 Type 3 surfaces. These will appear in superimposition, reports, and in the Status Tracker 
tool such as this example: (May 11, 2020) 

 
New divisions of the NVGATS also appear in reports and superimposition 

 

 

DAT/EM Capture for ArcGIS – ArcGIS Pro (Beta) 
This beta version is compatible with ArcGIS Pro versions: 

• ArcGIS Pro version 2.3, 2.3.1, 2.3.2, 2.3.3, 2.4, 2.4.1, 2.4.2, and 2.4.3. Please ask DAT/EM about any higher version 
numbers as they are released. 

• The API no longer needs to be present on the hardware lock. If you have Capture for ArcGIS and want to try Capture 
for ArcGIS Pro, use the DAT/EM CAD Enabler to activate the extension for ArcGIS Pro. 

DAT/EM Capture for ArcGIS Pro has the following changes: 

This was done in v.7.6, but was omitted from the 7.6 Release Notes. “API_enable” is no longer required to be on the 
hardware lock in order to use Capture for ArcGIS Pro. If you have Capture for ArcGIS and would like to activate it in 
ArcGIS Pro, use the DAT/EM CAD Enabler to activate the extension. (2019) 
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DAT/EM Capture and MapEditor for AutoCAD 
Changes apply to: 

32-bit AutoCAD 2004-2008 versions with the latest service packs, as long as you can get them to install on your 64-bit 
operating system (OS). DAT/EM no longer tests on 32-bit OS, so these must be running on 64-bit OS. DAT/EM is not responsible 
for helping to install a 32-bit version of AutoCAD on a 64-bit OS and cannot guarantee that this will succeed. 

64-bit AutoCAD 2009-2021 versions with the latest service packs. Exception: 64-bit AutoCAD 2008 is not supported. 

When referring to a year/version number in the lists above, it includes "plain" AutoCAD, Civil3D, and Map3D. It does not 
include AutoCAD LT, which is a 2D product, and therefore will never work with a 3D cursor. 

Reminders: 

• Install all available AutoCAD service packs and updates before installing DAT/EM software. 

• Before installing DAT/EM software, run each version of AutoCAD and make sure its license is active. Do this for each 
version whether or not you intend to use every version with DAT/EM Capture. 

DAT/EM software will install for multiple AutoCAD products of different year numbers on the same computer; however, it will only 
install for one of any multiple same-year versions. For example: 

• It will install for AutoCAD 2015, 2016, 2017 Civil3D, and Map3D 2018, because they are all different year versions. 

• It will not install for both AutoCAD 2017 and AutoCAD Civil3D 2017 at the same time, because they are both the same 
year. In the case of multiple same-year versions, only one of them will receive the DAT/EM files at installation. To activate 
DAT/EM Capture in all of them, the AutoCAD \datem folder and the DAT/EM wintab driver file may be copied from the one 
that received the files to the other same-year versions. Contact DAT/EM Support for instructions. 

Autodesk Infrastructure Design Suite installs three same-year AutoCAD versions (AutoCAD, Map3D, and Civil3D). Using the rules 
outlined above, you must run each version and register/”accept” each one before installing DAT/EM software whether or not you 
intend to run every version with DAT/EM Capture. DAT/EM software will install completely for only one of them, and we don’t know 
which one until after installation. The files may be copied manually to the others. Contact DAT/EM Support for instructions. 

DAT/EM Capture and MapEditor for AutoCAD have the following changes: 
 

1. Version 7.7 is the first DAT/EM version to install for AutoCAD 2021. (April 8, 2020) 

2. AutoCAD 2019 and 2020 would often crash when the user selected a color icon in the AutoCAD Layer Manager. 
Although it was AutoCAD that was crashing, it only crashed if any of the DAT/EM ARX applications were loaded. 
This is fixed. (March 4, 2020) 

DAT/EM Support asked the software engineer to put the fix in terms that the rest of us could possibly understand. 
This was the reply: 

Autodesk changed something in either the 2019/2020 API or the AutoCAD application itself that caused 
their User Interface to lose its mind when a Windows message was posted from an external thread. That 
should always be okay, but for some reason, it no longer was. 

The fix works around the problem by avoiding the newly crash-prone Autodesk FilterMessages function. 

Although AutoCAD 2018 and older did not have the problem, we applied the changes to DAT/EM applications for 
AutoCAD 2004 through 2018 as well so that our code remains consistent. 

3. The AutoCAD-side SI Settings Clip SI setting checked on could remove XREF (reference) file blocks from the 
entire superimposition display. The problem turned out to be AutoCAD not returning the right object extents on 
blocks inside reference files. In order to fix this, we now have to let all blocks within an intersecting reference file 
through to the SI display, even if they are outside the Clip SI bounds. This does not affect blocks in the main 
(open) file, because the block extents are returned correctly for it. (March 6, 2020) 
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4. Superimposition can now display different point sizes (widths) for AutoCAD POINT objects. It uses the Thickness 
setting for one or more selected points in AutoCAD’s Point Properties: 

 
The Point Properties Thickness setting in AutoCAD applies to one or more selected 

points. Superimposition will use Thickness to adjust its point size display. 

5. A problem was fixed in CAPT2D, CAPT3D, and AUTOARC3D. These commands could make an “illegal” single-
vertex polyline if they were canceled after digitizing just one vertex. To the user, it would seem as if the command 
successfully canceled, but it would leave an invisible single-vertex polyline. The next time the DWG was opened, 
either the AUDIT command or an automatic process would detect the single-vertex polyline and add a second 
vertex, and then you could see it as a point-like “dot” on the screen. Note that MapEditor MAPED CLEANUP has 
a setting to remove zero-length polylines, which you can use in DWG files made with v.7.6 or older. (May 4, 2020) 

 

 

. 
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DAT/EM Capture and MapEditor for MicroStation (32-bit versions) 
Changes in this section apply to Capture for 32-bit MicroStation versions installed on approved 64-bit Operating Systems as 
follows:  

• MicroStation V8** and V8 2004 Edition**: Version should be 08.05.00.34 or higher 

• MicroStation XM**: Version should be 08.09.04.88 or higher 

• MicroStation V8i, SelectSeries 2**, 3**, 4**, and 10 

• Bentley Map SelectSeries 2**, 3**, 4**, 10 

• MicroStation PowerView and Bentley Map PowerView SelectSeries 3**, 4**, and 10 

• Power GeoPak* SelectSeries 4** and 10 (contact DAT/EM Support if SelectSeries 10 has application loading issues) 

• PowerCivil SelectSeries 3**, 4**, and 10 

If you upgrade to a higher Select Series number, you must reinstall DAT/EM software after installing the SelectSeries upgrade.  

DAT/EM will install for all compatible versions of MicroStation (including products for MicroStation CONNECT) that are present 
on the computer at the time of the DAT/EM installation. 

DAT/EM Software may install for SelectSeries 1 versions, but SelectSeries 1 had many problems. DAT/EM does not officially 
support our software running with any Bentley SelectSeries 1. 
 
**Note about 32-bit MicroStation versions: Be aware of the situation! DAT/EM v.7.7 is only supported on Windows 8.1 and 
Windows 10, with Windows 10 being by far the most widely used and recommended. The only 32-bit MicroStation versions 
that Bentley officially supports on Windows 10 are SelectSeries 4 and 10. Therefore, we are in a difficult position of supporting 
more MicroStation versions than Bentley actually supports for their customers. DAT/EM will continue to install for V8, XM, and 
the older SelectSeries versions if they are found on the computer, and will continue to do this as long as possible. If Bentley 
stops licensing these older versions to DAT/EM for development, then DAT/EM will not be able to compile for them, and will 
have to drop them at that time. We don’t know how long Bentley will allow DAT/EM to use the old versions. 
 
Note that DAT/EM has found SelectSeries 10 to be superior to SelectSeries 4 and older. SelectSeries 10 has fixes to long-
standing problems found in older SelectSeries. DAT/EM recommends SelectSeries 10 if you are using V8i. 
 

DAT/EM Capture and MapEditor for MicroStation have the following changes: 

 
General Subjects in Capture and MapEditor for 32-bit MicroStation versions 

1. DAT/EM v.7.7 has added MicroStation V8i SelectSeries 10 and CES to its compatibility lists. SelectSeries 10 
actually installs and works for the previous v.7.6 as well, but since it was released about the same time as 7.6, we 
had not included it in the 7.6 Release Notes. (May and July 2019) 

2. The DAT/EM CAD Enabler application can now enable and disable DAT/EM applications for 32-bit and 64-bit 
MicroStation versions separately. Previously, they would all be enabled or disabled together. (May 14, 2020) 

3. There was a problem with all view independent text in Summit’s superimposition (SI). For example, the tentative 
point elevation text based on the settings in DATEM SETTINGS is view independent text. It was shown at zero 
degrees to the Summit model’s kappa rather than zero degrees on screen. View independent text will now always 
be displayed in SI at zero degrees on screen. (June 12, 2019) 

4. The default stroke tolerance set in DATEM SETTINGS was not being read or written to the configuration file. This 
is fixed. (May 7, 2019) 

5. The Move stereoplotter to tentative setting in DATEM SETTINGS was not always working in V8i SelectSeries 3 
and 4. This is fixed. (June 24, 2020) 

6. Summit’s superimposition (SI) will now show the MicroStation “snap” commands in the SI CAD command text 
area if they are sent by a Summit digitizer button, the DAT/EM Keypad, or the MicroStation Keyin Browser. Since 
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MicroStation does not publish its own toolbar selections, the command will not appear in SI if you use the 
MicroStation toolbar to select a different snap lock or turn Accusnap on/off. (December 31, 2019) 

 
SNAP commands display in the CAD command area  

7. The Selection Sets Editor has a minor fix to make its Edit and New dialogs modal, so you must answer them with 
OK or Cancel before returning to the main Selection Sets Editor dialog. (January 14, 2020) 

8. Superimposition can now display different point sizes for zero-length lines and line strings (points). For 
MicroStation to send the point width to superimposition, set the custom width attribute or ByLevel width attribute 
for the zero-length line or line string. To display the width, check on the MicroStation-side SI SETTINGS > Show 
Line Weight setting. The Summit-side Tools > Options > SI tab > Points size may be a factor of the width as 
well. To turn off the setting, turn off SI SETTINGS > Show Line Weight, so that it returns to the size set in the 
Summit-side setting without factoring the MicroStation line weight. (March 31, 2020) 

 
 

New Commands in Capture and MapEditor for 32-bit MicroStation versions 
There are no new commands in Capture and MapEditor for MicroStation in v.7.7. 

 
Changes to Existing Commands in Capture and MapEditor for 32-bit MicroStation versions 

1. Several commands had cell name menus that were truncated to only a few characters. It was difficult to select 
from a list of cells that all started with the same first characters. More characters will now display in the following 
commands: SPOTX SETTINGS (in Capture and MapEditor), DATEM PROFILE, XSECT MODE, ANNOTATE, 
DTM SAMPLE DLG, DTM INSERT DLG. 

2. 3DOFFSET has a fix for a boundary condition problem that would cause the wrong elevation in offsetting a closed 
(end-to-end snapped) line string or shape. The problem could only occur with closed elements that had the same 
number of vertices (original and parallel copies), but non-parallel beginning and ending vertices. (January 22, 2020) 
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3. ATTACH REFERENCE in the MapEditor parameter file will now always attach references with the “Coincident 
World” attachment setting on. (October 3, 2019) 

4. AUTOARC has the following fixes and enhancements: 

a. AUTOARC superimposition could look incorrect in both superimposition and in the MicroStation view 
when one or more Undos were submitted during drawing. There were issues in the display for both the 
rubber band and for the superimposed in-progress object. These issues are fixed. (August 1, 2019) 

b. Arc rubberbanding was added to AUTOARC superimposition. This draws the proposed arc over the 
Summit view, whereas previously it drew only straight segments from the start point to the point along the 
arc and the end of the arc. (August 1, 2019) 

5. Change Attributes Interior (MECHANGEINTERIOR) was ignoring text objects. This is fixed. (June 19, 2019) 

6. CROSSCHECK calls a Bentley MDL function that could crash in a rare case of processing a near-colinear line 
string element. DAT/EM reported the error to Bentley and also added error checking to MapEditor so that it can 
avoid the crash. (January 1, 2020) 

7. DATDRAW AUTOARC has the following changes: 

a. Arc rubberbanding was added to DATDRAW AUTOARC superimposition. This draws the proposed arc 
over the Summit view, whereas previously it drew only straight segments from the start point to the point 
along the arc and the end of the arc. (May 24, 2019) 

b. Superimposition artifacts were removed for the second to last vertex on line mode Undo. (May 24, 2019) 

c. DATDRAW AUTOARC could stop drawing arcs successfully after a certain sequence of Undos were 
used during drawing. This is fixed. (May 24, 2019) 

8. DATDRAW TRACE has a fix to prevent a MicroStation crash. (March 10, 2020) 

9. DATEM PROFILE will now show more characters in the cell name pull-down menu. (October 31, 2019) 

10. Densify (MEDENSIFY) had an issue with adding too many points to segments that had much different elevations 
on the segment endpoints. Sometimes the extra points would overshoot the end of the original segment, and 
other times they would zig zag back and forth along the original segment. This is fixed. (September 25, 2019) 

11. DTM FENCE DLG has a new option, Move in XY only. When off (default), Summit moves to the (x,y,z) of each 
point, vertex, or cell insertion point. When checked on, it moves in (x,y) only, keeping the current stereoplotter 
elevation. (November 26, 2019) 

 

New Move in XY only setting in DTM FENCE DLG: 

• Move in XY off might be better if the objects 
are already near the ground and require only 
a small adjustment. 

• Move in XY on might be better if the objects 
are very far off the ground, or even at z=0. In 
this case, moving in (x,y) prevents large, 
undesired elevation jumps between objects. 
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12. DTM SAMPLE DLG and DTM INSERT DLG will now show more characters in the cell name pull-down menu. 
(October 31, 2019) 

13. ELEVATE (drape tool) has the following changes: 

a. ELEVATE’s file list has a new “Clear all files” button that removes all previously listed files. (April 16, 2020) 

b. ELEVATE’s DTM Files browse dialog can now select multiple files at one time. (April 16, 2020) 

c. ELEVATE is now available to add to a MapEditor parameter file. Previously, it was only available in a 
dialog for the semi-interactive run method. (July 17, 2019) 

 
Elevate is now in the Command list in the Parameter File Editor 

 
Elevate settings for the parameter file version 
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Elevate added to a line in the parameter file 

14. LD CP DLG (Load Control dialog) has the following fixes: (July 26, 2019) 

a. The three Settings buttons in LD CP DLG activated dialogs that should have been modal (required 
closing to get back to the main dialog), but they were non-modal. The result was that if you didn’t OK or 
Cancel them, they would still be on screen after the command was run. The dialog type was changed. 

b. Added checks and ensured registry setting for the three Settings dialogs to make sure the font setting 
changes were applied on OK, or not applied on Cancel. 

c. Added a redundancy check for duplicate cell names so they will only appear in the cell list one time. 

d. The cell combobox event handler for LD CP DLG and XSECT MODE had redundant event definitions. It 
was possible for the cell list to return to the wrong dialog. This is fixed. 

e. The cell combobox for both LD CP DLG and XSECT MODE were being initialized from the wrong event 
when the dialog was first being created. This is fixed so it properly happens upon completion. 

f. Added diagnostic messages to help the user know when a cell that is being called is not actually defined. 

g. Fixed a numeric overflow problem in a common library function used by LD CP DLG and a number of 
other “older” commands, including XSECT ASSOCIATE, XSECT NUMBER, REPCELL, and SPOTX. 

h. Fixed a problem where the configuration file parser was sometimes neglecting to strip line feeds from the 
input stream. 

15. MEADDTAGS and MECHANGETAG have the following changes: 

a. MEADDTAGS and MECHANGETAG have a fix for their “Process Elements using Fence” option. It was 
not treating the fence lock setting correctly. Of all the possible fence lock settings, Inside, Overlap, and 
Clip all worked like Overlap. Also Void, Void-Overlap, and Void-Clip all worked like Void-Overlap. If a user 
needed to tag elements that were completely inside or completely outside a fence, it incorrectly included 
elements that crossed or intersected the fence. This affected non-zero length elements that spanned 
fence boundaries. (June 18, 2019) 

b. MEADDTAGS has a new option to allow the user to place either a fixed tag value or an incremental 
value. If the incremental value is selected, the tag type may be a character type, but it will increment the 
values as if they are integers starting at a user-defined value. For example, enter 100 for a character type 
tag, and it will set the indicated tag in the first five processed objects to the characters 100, 101, 102, 103, 
and 104. (July 2, 2019) 

 
New Fixed and Incremental Tag Values choice 
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If “Fixed Tag Value(s)” is selected, the tag value field (“2001” in the example bellow) is placed verbatim 
for each tag value added. 

 
New settings for the “Fixed Tag Value(s)” option 

If “Incremental Tag value(s)” is selected, the following field is used to derive the value of each placed tag. 

 If the value specified is numeric (e.g. 2001 in the example below), the first tag value will 
be 2001, the next will be 2002, then 2003, and so on.  

 If the value specified is not numeric, it will be used as a prefix. For example, if a prefix 
value of “Ground topo” is specified, tag values would be assigned as “Ground topo 1”, 
“Ground topo 2”, “Ground topo 3”, and so on. 

 
Example “Incremental Tag value(s)” setting 

In addition, the following keyins have been added: 

• MEADDTAGS FIXEDVALUE <fixed value> 
This specifies the fixed value as if it had been entered in the Fixed Tag Value(s) dialog setting. 
 

• MEADDTAGS INCVALUE <starting value or prefix> 
This specifies the starting value as if Increment Tag values starting at: had been selected and the 
<starting value or prefix> integer had been keyed in to the dialog. 

 
When Tag Modification “add Tag Set (default missing Tags)” is specified, all missing tags (associated with 
the specified Tag Set) are added to select elements.  Because this command operates on a full tag set, 
Tag Name and value specifiers (including the new ones) are disabled. 
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Example “Add Tag Set (default missing Tags)” setting 

However, it’s possible to re-run MEADDTAGS afterward specifying “Replace existing Tag Value(s)” with 
“Incremental Tag Values” to replace the previously defaulted tags with incremental ones. 

c. MEADDTAGS and MECHANGETAG have added error checking and diagnostics for invalid 
configurations. (July 15, 2019) 

d. The keyin MEADDTAGS INCVALUE <starting value or prefix> was not working, although the dialog 
box version of this setting was working. This is fixed. (July 9, 2019) 

16. MESCALE (command line and parameter file versions) has the following enhancements: (August 7, 2019) 

a. Added X and Y only and X, Y, and Z choices. If you select X and Y only, the Z coordinates will remain at 
their original values. 

 
b. Changed the prompts for the existing scale presets and added more presets for the most-used unit 

conversions. These are for U.S. and International foot and meters units. For any other scale, continue to 
use “Custom” and key in the scale factor. 

 
New prompts visible in Scale Settings 
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17. PSQR has the following improvements: (September 9, 2019) 

a. PSQR keyins were disabled by PSQR’s shortcut keyin overrides (for example, “A” to change angle or “S” 
to disable the squaring angle for one segment). Now PSQR can process all of its keyins even if these 
shortcut keyins have been used. 

b. The PSQR PITCH TOGGLE keyin was missing in the command table. It is now in the command table. 

18. ROAD SETTINGS has the following fixes: 

a. ROAD SETTINGS Run button was not fetching the most current settings and in some cases might 
overwrite the registry with stale settings. This is fixed. (February 25, 2020) 

b. ROAD SETTINGS Run button could fail to close the dialog as it started the drawing command. This 
wouldn’t always happen, but was a possibility. This is fixed. (March 16, 2020) 

19. SI SETTINGS > Show Line Weight now also includes weights on points (zero-length lines and line strings). See 
more information in item 8 on page 45 above. (March 31, 2020) 

20. SPOTX SETTINGS (both the keyin and in the MapEditor) will now show more characters in the cell name pull-
down menu. (October 31, 2019) 

21. TOUCH ELEMENT has enhanced error checking and a fix for a condition where it would crash. (April 6, 2020) 

22. VISIT ELEMENTS has a new filter to show line strings with a certain number of vertices. Examples of use: Find all 
2- and 3-vertex line strings, or find all strings over 5000 vertices.  (February 27, 2020) 

 
New minimum and maximum vertices filters for VISIT ELEMENTS 

Previous Area and Length filters remain available, but combinations of filters are not currently supported. 
 
These filters apply to linear elements with the caveats that a fixed vertex count of three is estimated for arcs/arc 
components in complex elements. Ellipses are treated as having five vertices. These rules can be easily refined if 
needed (though it is expected the other filters would be used for these types of elements). 

23. XSECT MODE will now show more characters in the cell name pull-down menu. (October 31, 2019) 

 

DAT/EM Capture (Beta) for MicroStation CONNECT Products (64-bit versions) 
Changes apply to Capture (beta) for MicroStation CONNECT Edition (CONNECT) and products built on the CONNECT 
platform. DAT/EM software installs for the following CONNECT versions on 64-bit operating systems:  

• MicroStation CONNECT Edition Version 1.x Updates* 10-14**, Update numbers released up to May 14, 2020 

• OpenRoads Designer CONNECT Edition, Update numbers* released up to May 14, 2020 

• OpenCities Map CONNECT Edition – Update numbers* released up to May 14, 2020 

*Starting in version 7.7, DAT/EM software will install for CONNECT version values greater than 100000000 and less than 
109900000 with a ProgramPath anywhere under the Software\Bentley\Installed_Products key in the registry. If your CONNECT 
version has a number older than this, we suggest updating it. Despite installing for some rather old versions, we do not guarantee 
Capture will work with them if CONNECT itself has bugs in functions that we access. Update numbers for the differently named 
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products are not synchronized by Bentley, so DAT/EM refers to Bentley “Update” release dates. For CONNECT version and 
Update numbers released after May 14, 2020, contact DAT/EM Support to check on compatibility. 

**MicroStation CONNECT Edition Update 14 was released only a few days before May 14, 2020. Testing with this has been 
limited, but we believe it works with DAT/EM v.7.7. The SDK for Update 14 was not released by May 14, 2020; therefore, DAT/EM 
Capture v.7.7 for MicroStation CONNECT Edition Update 14 is based on the Update 13 SDK. 

General information about Capture for MicroStation CONNECT: 

• DAT/EM v.7.7 contains the most-used Capture commands, including PSQR, AUTOARC, SPOTX, etc. Capture for 
Summit Lite is complete (it has far fewer Capture tools than Feature Collection or Professional). More Capture 
and MapEditor commands will be added during next beta development cycle following v.7.7. 

• You are welcome to use Capture for CONNECT in v.7.7; however, if you want to use the most available 
commands, ask DAT/EM Support for access to the next version’s betas. By using the latest beta versions, you 
can always have the most commands available to date. 

• There will be a table of keyins posted with the betas in the beta downloads folder. Please refer to the beta version 
table to see which commands are available. 

• The Summit Button Manager settings will communicate with MicroStation CONNECT, but “User CAD” and 
“Generic CAD” buttons that call DAT/EM drawing and editing commands are restricted to the keyins that were 
available at the time the beta was compiled. 

• The DAT/EM Keypad Controller communicates with MicroStation CONNECT and uses the same keypad overlay 
as the earlier versions of MicroStation. Note that only the commands that have been activated in the installed 
version will work when submitted by the keypad string. 

• The DAT/EM CAD Enabler can now enable and disable applications for 32- and 64-bit MicroStation versions 
separately. Note that V8 2004 Edition, XM, and V8i SelectSeries are all 32-bit versions, and any products with 
“CONNECT” or “Open” in the Bentley name is a 64-bit version. (May 14, 2020) 

 

 

CAD Enabler with separate 32- and 64-bit MicroStation options 

Known problems with Bentley CONNECT products:  

• The Bentley MicroStation CONNECT SDK has removed the previously available tentative point event 
notification. This means tentative point text and markers can’t be displayed in Summit’s superimposition. We 
have no explanation on why they would remove such an important function. 

• There are major errors in the Bentley CONNECT products’ 3D parallel offset function, which DAT/EM needs 
to call for our 3DOffset and Road offset tools. We must wait for Bentley to fix this function. 
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DAT/EM Capture for Blue Marble Global Mapper 
Changes apply to Capture for Global Mapper. DAT/EM Capture for Global Mapper is supported for the following Global 
Mapper versions: 17.1.2 or higher, 18.x, 19.x, 20.x, 21.x up to the time of the v.7.7 release. Please ask DAT/EM Support whether 
later versions are compatible. 

Notice: If you use DAT/EM Capture for Global Mapper, please contact support@datem.com or your reseller immediately. 
The information you provide could help determine the future of this product. If we do not hear from you in support of this 
product, there is a possibility we could discontinue it in 2021. Your vote matters! 

Advice for enabling and disabling the DAT/EM Capture extension for Blue Marble Global Mapper: 

DAT/EM Software installs the Global Mapper Extension, but leaves it unregistered in Global Mapper by default. 
To use the extension, close Global Mapper, select Windows Start > All Programs > Datem Software > Utilities > 
CAD Enabler, set Global Mapper=Capture, and select OK. Likewise, to disable, set CAD Enabler to Global 
Mapper=Disable. 

   
To register/enable or unregister/disable, use the DAT/EM CAD Enabler 

The only change for Capture for Global Mapper v.7.7 is the addition of compatibility with Global Mapper version 21.x 
as released up to the time of the DAT/EM v.7.7 release. For later versions, contact DAT/EM Support. 

 

 

 

 

 

 

 

 

 

 

-End- 
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